TITLE: DG-5.1: DEVELOPMENT PROJECT PLAN GUIDELINE VERSION 3.0

AUTHORS:

Ken Jensen (Raytheon Information Solutions)

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>No version 1.0.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.0</td>
<td>No version 2.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.1</td>
<td>New Research Project Plan (RPP) Guideline (DG-6.1), adapted from CMMI guidelines by Ken Jensen (Raytheon Information Solutions)</td>
<td>New Document</td>
<td>03/30/2008</td>
</tr>
<tr>
<td>3.0</td>
<td>Renamed Development Project Plan (DPP) Guideline (DG-5.1) and revised by Ken Jensen (RIS)</td>
<td>2……</td>
<td>10/01/2009</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIST OF ACRONYMS</td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>1. INTRODUCTION</td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>1.1. Objective</td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>1.2. The Development Project Plan</td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>1.3. Background</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>1.4. Benefits</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>1.5. Overview</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>2. REFERENCE DOCUMENTS</td>
<td></td>
<td>9</td>
</tr>
<tr>
<td>3. STANDARD TABLE OF CONTENTS</td>
<td></td>
<td>10</td>
</tr>
<tr>
<td>4. SECTION GUIDELINES</td>
<td></td>
<td>12</td>
</tr>
<tr>
<td>4.1. Table of Contents</td>
<td></td>
<td>12</td>
</tr>
<tr>
<td>4.2. List of Figures</td>
<td></td>
<td>12</td>
</tr>
<tr>
<td>4.3. List of Tables</td>
<td></td>
<td>12</td>
</tr>
<tr>
<td>4.4. List of Acronyms</td>
<td></td>
<td>13</td>
</tr>
<tr>
<td>4.5. Section 1 – Introduction</td>
<td></td>
<td>13</td>
</tr>
<tr>
<td>4.6. Section 2 – Project Objectives</td>
<td></td>
<td>14</td>
</tr>
<tr>
<td>4.7. Section 3 – Project Stakeholders</td>
<td></td>
<td>14</td>
</tr>
<tr>
<td>4.8. Section 4 – Statement of Work</td>
<td></td>
<td>15</td>
</tr>
<tr>
<td>4.9. Section 5 – Project Lifecycle</td>
<td></td>
<td>16</td>
</tr>
<tr>
<td>4.10. Section 6 – Technical</td>
<td></td>
<td>17</td>
</tr>
<tr>
<td>4.11. Section 7 – Integrated Master Plan</td>
<td></td>
<td>21</td>
</tr>
<tr>
<td>4.12. Section 8 – Integrated Master Schedule</td>
<td></td>
<td>22</td>
</tr>
</tbody>
</table>
4.13.  Section 9 – Budget ................................................................. 23
4.14.  Section 10 – List of References ............................................. 25

APPENDIX A - EXAMPLES .................................................................................. 26

APPENDIX B - TEMPLATES ................................................................................ 27
  B.1 Cover Page Template: ................................................................. 28
  B.2 Document Header Template: ....................................................... 29
  B.3 Document Cover Page Footer Template: ................................. 29
  B.4 Document Footer Template: ......................................................... 29
  B.5 Approval Page Template: ............................................................. 30
  B.6 Version History Page Template: .................................................. 31
  B.7 Figure Caption Template: ............................................................. 32
  B.8 Table Title Template: ................................................................. 32
  B.9 List of References Template: ....................................................... 33
### LIST OF ACRONYMS

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDR</td>
<td>Critical Design Review</td>
</tr>
<tr>
<td>CICS</td>
<td>Cooperative Institute for Climate Studies</td>
</tr>
<tr>
<td>CIMSS</td>
<td>Cooperative Institute for Meteorological Satellite Studies</td>
</tr>
<tr>
<td>CI OSS</td>
<td>Cooperative Institute for Oceanographic Satellite Studies</td>
</tr>
<tr>
<td>CIRA</td>
<td>Cooperative Institute for Research in the Atmosphere</td>
</tr>
<tr>
<td>CL</td>
<td>Check List</td>
</tr>
<tr>
<td>CLI</td>
<td>Check List Item</td>
</tr>
<tr>
<td>CMMI</td>
<td>Capability Maturity Model Integration</td>
</tr>
<tr>
<td>CPI</td>
<td>Cost Performance Index</td>
</tr>
<tr>
<td>CREST</td>
<td>Cooperative Remote Sensing and Technology Center</td>
</tr>
<tr>
<td>DG</td>
<td>Document Guideline</td>
</tr>
<tr>
<td>DPP</td>
<td>Development Project Plan</td>
</tr>
<tr>
<td>EPL</td>
<td>Enterprise Product Lifecycle</td>
</tr>
<tr>
<td>EVMS</td>
<td>Earned Value Management System</td>
</tr>
<tr>
<td>IMP</td>
<td>Integrated Master Plan</td>
</tr>
<tr>
<td>IMS</td>
<td>Integrate Master Schedule</td>
</tr>
<tr>
<td>IPT</td>
<td>Integrated Product Team</td>
</tr>
<tr>
<td>MOU</td>
<td>Memorandum of Understanding</td>
</tr>
<tr>
<td>NESDIS</td>
<td>National Environmental Satellite, Data, and Information Service</td>
</tr>
<tr>
<td>NOAA</td>
<td>National Oceanic and Atmospheric Administration</td>
</tr>
<tr>
<td>PAR</td>
<td>Process Asset Repository</td>
</tr>
<tr>
<td>PDR</td>
<td>Preliminary Design Review</td>
</tr>
<tr>
<td>PP</td>
<td>Project Proposal</td>
</tr>
<tr>
<td>PRG</td>
<td>Peer Review Guideline</td>
</tr>
<tr>
<td>PRR</td>
<td>Project Requirements Review</td>
</tr>
<tr>
<td>QA</td>
<td>Quality Assurance</td>
</tr>
<tr>
<td>SG</td>
<td>Stakeholder Guideline</td>
</tr>
<tr>
<td>SOW</td>
<td>Statement of Work</td>
</tr>
<tr>
<td>SPI</td>
<td>Schedule Performance Index</td>
</tr>
<tr>
<td>SPSRB</td>
<td>Satellite Products and Services Review Board</td>
</tr>
<tr>
<td>SRR</td>
<td>System Readiness Review</td>
</tr>
<tr>
<td>STAR</td>
<td>Center for Satellite Applications and Research</td>
</tr>
<tr>
<td>TD</td>
<td>Training Document</td>
</tr>
<tr>
<td>TG</td>
<td>Task Guideline</td>
</tr>
<tr>
<td>WBS</td>
<td>Work Breakdown Structure</td>
</tr>
</tbody>
</table>
1. INTRODUCTION

The NOAA/NESDIS Center for Satellite Applications and Research (STAR) develops a diverse spectrum of complex, often interrelated, environmental algorithms and software systems. These systems are developed through extensive research programs, and transitioned from research to operations when a sufficient level of maturity and end-user acceptance is achieved. Progress is often iterative, with subsequent deliveries providing additional robustness and functionality. Development and deployment is distributed, involving STAR, the Cooperative Institutes (CICS, CIMSS, CIOSS, CIRA, CREST) distributed throughout the US, multiple support contractors, and NESDIS Operations.

NESDIS/STAR is implementing an increased level of process maturity to support the exchange of these software systems from one location or platform to another. The Development Project Plan (DPP) is one component of this process.

1.1. Objective

The objective of this Document Guideline (DG) is to provide STAR standards for the DPP. The intended users of this DG are the personnel assigned by the Project Lead to the task of creating a DPP for the project.

1.2. The Development Project Plan

The DPP is a formal, approved document used to manage and control the execution of the project. It documents the plan for the development, testing, review, and transition to operations for the project, including stakeholders, tasks, work breakdown structure (WBS), schedule and resources. It should describe the project objectives, tasks, milestones, stakeholders, and schedule. It should establish the work products to be produced by the project, the processes to be followed, the criteria for determining the project’s compliance with the plan, and the criteria for initiating corrective actions. It should tie all of these plan items together in an Integrated Master Plan (IMP) and corresponding Integrated Master Schedule (IMS).

The DPP should define all aspects of the effort, tying together in a logical manner: project life-cycle considerations; technical and management tasks; budgets and schedules; milestones; data management, risk identification, resource and skill requirements; and stakeholder identification and interaction. The DPP should consider all phases of the project life cycle. Project planning should ensure that all plans affecting the project are consistent with the overall project plan.
Three versions of the DPP are produced during the STAR Enterprise Product Lifecycle (EPL)\(^1\).

DPP v1r0, produced for the Gate 3 Review \(^2\), should include the entire project plan at a level of detail that is appropriate at the end of the Plan phase of the product lifecycle. At this phase, requirements development and design development are immature. Therefore, the technical description will be preliminary.

DPP revisions (v1r1, v1r2, etc.) are produced as necessary to document changes to the project objectives, tasks, milestones, stakeholders, and/or schedule that may occur after the Gate 3 Review, but prior to the commencement of the next EPL phase. Changes could result from actions generated by the Gate 3 Review.

DPP v2r0, produced for the Project Requirements Review (PRR), is a planned update that is intended to contain a more detailed plan to reflect the more detailed requirements development and definition of work products that occurs during the Design phase of the product lifecycle. Mainly, this involves an upgrading of the technical description and a refinement of the schedule and budget to accommodate the more detailed technical description.

DPP revisions (v2r1, v2r2, etc.) are produced as necessary to document changes to the project objectives, tasks, milestones, stakeholders, and/or schedule that may occur during the Design phase of the STAR EPL. DPP revisions will be reviewed for approval at the Preliminary Design Review (PDR), Critical Design Review (CDR), and Gate 4 Review.

DPP v3r0, produced for the Test Readiness Review (TRR), is a planned update that is intended to reflect plan revisions that may occur during the Build phase of the product lifecycle. Mainly, this involves a refinement of the technical description, schedule, budget, and risks.

DPP revisions (v3r1, v3r2, etc.) are produced as necessary to document changes to the project objectives, tasks, milestones, stakeholders, and/or schedule that may occur during the Build phase of the STAR EPL. DPP revisions will be reviewed for approval as

\(\text{\footnotesize\textsuperscript{1}}\) For a description of the STAR EPL, refer to the STAR EPL Process Guideline (PG-1 and PG-1.A).

\(\text{\footnotesize\textsuperscript{2}}\) Refer to the STAR EPL Process Guideline (PG-1 and PG-1.A) for a description of the STAR EPL gates and reviews.
necessary at the Code Test Review (CTR), System Readiness Review (SRR), and Gate 5 Review.

The DPP should be developed as a Microsoft Word document. Upon approval, the approved version of the DPP may be converted to an Adobe pdf file for storage in the project artifact repository.

1.3. Background

This DG defines guidelines for producing a DPP. This DG has been adapted from Capability Maturity Model Integration (CMMI) guidelines (CMMI-DEV-v1.2, 2006). It has been tailored to fit the STAR EPL process.

1.4. Benefits

A DPP developed in accordance with the standards in this DG assists the development team to provide necessary quality assurance of the products and product components. It is therefore a requirement that a DPP be developed in accordance with the guidelines in this document.

1.5. Overview

This DG contains the following sections:

- Section 1.0 - Introduction
- Section 2.0 - References
- Section 3.0 - Standard Table of Contents
- Section 4.0 - Section Guidelines
- Appendix A - Examples
- Appendix B - Templates
2. REFERENCE DOCUMENTS

All of the following references are STAR EPL process assets that are accessible in a STAR EPL Process Asset Repository (PAR) on the STAR web site:


**PG-1: STAR EPL Process Guideline** provides the definitive description of the standard set of processes of the STAR EPL.

**PG-1.A: STAR EPL Process Guideline Appendix**, an appendix to PG-1, is a Microsoft Excel file that contains the STAR EPL process matrix (Stakeholder/Process Step matrix), listings of the process assets and standard artifacts, descriptions of process gates and reviews, and descriptions of stakeholder roles and functions.

**PG-2: STAR EPL Tailoring Guideline** provides guidelines for determining a project’s define process by tailoring the STAR EPL standard set of processes.

**PRG-5: Gate 3 Review Guidelines** are the guidelines for the Gate 3 Review. It is useful for the DPP developers to understand what the reviewers will expect when reviewing the DPP.

**CL-5: Gate 3 Review Check List** is the check list for the Gate 3 Review. It is useful for the DPP developers to understand the specific Check List Items (CLI) that the reviewers of the DPP will be required to approve.

**DG-0.1: STAR Document Style Guideline** is a STAR EPL Document Guideline (DG) that provides STAR standards for the style and appearance of STAR documents developed as Microsoft Word files.


**TG-5: STAR EPL Step 5 Task Guidelines** provides a description of standard tasks for process step 5, during which the DPP is developed.
3. STANDARD TABLE OF CONTENTS

LIST OF FIGURES
LIST OF TABLES
LIST OF ACRONYMS

1.0 INTRODUCTION

2.0 PROJECT OVERVIEW
  2.1 Project Objectives
  2.2 Concept of Operations

3.0 PROJECT STAKEHOLDERS
  3.1 Suppliers
  3.2 Developers
  3.3 Operators
  3.4 Users
  3.5 Reviewers
  3.6 Management and Support

4.0 STATEMENT OF WORK
  4.1 Work Tasks
  4.2 Work Breakdown Structure
  4.3 Deliverable Items

5.0 PROJECT LIFECYCLE
  5.1 Lifecycle Steps
  5.2 Reviews

6.0 TECHNICAL
  6.1 Requirements
6.2 Constraints
6.3 Tasks
6.4 Work Products
6.5 Resources
6.6 Risks
6.7 Corrective Actions

7.0 INTEGRATED MASTER PLAN

8.0 INTEGRATED MASTER SCHEDULE

9.0 BUDGET
  9.1 Cost
  9.2 Funding
  9.3 Risks
  9.4 Earned Value Management

10.0 LIST OF REFERENCES
4. SECTION GUIDELINES

This section contains the STAR guidelines for each section of the DPP.

The DPP should follow the STAR standard for style and appearance, as stated in DG-0.1.

4.1. Table of Contents

The Table of Contents can be inserted by using Word’s Insert → Reference → Index and Tables → Table of Contents function or by pasting the Table of Contents from this DG into your document and updating it for the section headers you make for your document. Use a page break if necessary to ensure that the Table of Contents appears at the top of a page.

4.2. List of Figures

A List of Figures should be provided after the Table of Contents. A page break should be used if necessary to ensure that the List of Figures appears at the top of a page. To create a List of Figures, use Word’s Insert → Reference → Index and Tables → Table of Figures function, selecting the “Table of Figures” Style. Alternatively, the List of Figures can be created by pasting the List of Figures for this DG into your document.

Figures should be created by using Word’s Insert → Picture → From File function or Word’s Insert → Object function. Figures should be numbered X.Y, where X is the main section number where the figure resides and Y = 1,N is the ordered number of the figure in the section. Figure captions should have Arial bold 12 point font, should be center justified, and should have a “Table of Figures” Style. A Figure Caption template is provided in Appendix B of this DG.

4.3. List of Tables

A List of Tables should be provided after the List of Figures. The List of Tables can appear on the same page as the List of Figures, with three blank lines separating them, provided both lists can fit on the same page. If both lists cannot fit on the same page, a page break should be used to ensure that the List of Tables appears at the top of a page.
To create a List of Tables, use Word’s Insert ➔ Reference ➔ Index and Tables ➔ Table of Figures function, selecting the “Table - Header” Style. Alternatively, the List of Tables can be created by pasting the List of Tables for this DG into your document.

Tables should be created with the Table ➔ Insert ➔ Table function. Tables should be numbered X.Y, where X is the main section number where the table resides and Y = 1,N is the ordered number of the table in the section. Table titles should have Arial bold 12 point font, should be center justified, and should have a “Table - Header” Style. A Table Title template is provided in Appendix B of this DG. Table text should have Arial regular 10 point font.

4.4. List of Acronyms

The use of acronyms is encouraged. A two word or longer name for an item (e.g., Development Project Plan) should be given an acronym (e.g., DPP) if the name is used more than once in the document. A List of Acronyms should be provided after the List of Tables. The List of Acronyms should be in alphanumeric order. Use the List of Acronyms in this DG as a template. A page break should be used if necessary to ensure that the List of Acronyms appears at the top of a page.

4.5. Section 1 – Introduction

The DPP shall include an Introduction Section. This section shall include

- A well-defined purpose and function for the document
- Specific intended user(s)
- How the intended user(s) should use the document
- A responsible entity for generating the document
- A responsible entity for review/approval of the document
- A responsible entity for storage, accessibility, and dissemination
- A brief overview of the contents of each main section
4.6. Section 2 – Project Overview

List the project objectives. These should be derived from customer needs and expectations (User Request, ConOps), and should have been captured in the project’s Statement of Work (SOW), SPSRB Plan, and the Project Proposal (PP).

Provide an initial description of the customer/user’s concept of operations (ConOps) from which requirements are to be derived. If a customer ConOps document exists, refer to it.

4.7. Section 3 – Project Stakeholders

Identify relevant stakeholders. For each stakeholder, note the rationale for their involvement, their roles and their responsibilities. Note whether stakeholder roles and responsibilities have been tailored from the STAR standard, and how.

Typically, there is a diverse set of project stakeholders. In that case, use separate subsections for each major type of stakeholder (e.g., Suppliers, Developers, Operators, Users, Reviewers, and Management and Support).

- A subsection for Suppliers would identify organizations that will be supplying hardware, software, personnel, and other resources (e.g., data). Include supplier agreements. These can be included as appendices and/or references to external documents (e.g., contract, MOU, SOW, licensing agreement). If new supplier agreements are needed after the Plan phase, include them in a DPP revision. Include requirements to be met by each supplier. Demonstrate that these requirements will be met by performance of the supplier agreement. Identify what the project will provide for each supplier (e.g., facilities documentation, training). These should be consistent with supplier agreements and with Giver-Receiver lists. Identify any supplier processes that should be monitored to ensure the success of the project. The tasks in the IMP (c.f. Sections 4.10 and 4.11 of this DG) should include the monitoring of any identified processes.

- A subsection for Developers would identify the roles and key personnel for the team that will be developing the product processing system for transition to operations.

- A subsection for Operators would identify all organizations that will be responsible for operations and for maintenance. Identify key personnel that are known.

- A subsection for Users would identify all customers and end users of the project’s deliverable products. In addition, note the specific roles that are intended for each customer and end user.
• A subsection for Reviewers would identify the designated Review Lead and Review Team members for each project review, and would document review stakeholder acceptance of their roles.

• A subsection for Management and Support would identify the management roles. This includes project management, configuration management, data management, systems administration, and quality assurance roles. Identify key personnel.

4.8. Section 4 – Statement of Work

This section should contain a comprehensive Statement of Work (SOW) for the project. This can be adapted from a pre-existing SOW drafted by a customer. Subsections should include Work Tasks, Work Breakdown Structure and Deliverable Items.

• The subsection for Work Tasks should state the tasks to be completed by the project stakeholders, from the point of view of the customers and end users. These should be obtainable from the PP and from customer requirements documents. The work tasks included in this subsection should reflect the needs and expectations of all approved customers and end users. If you asked your customer/users what work tasks they expect you will be doing, what would their answer be? That is what should go into this section. High-level tasks from the user’s point of view are typically oriented to creation, delivery and maintenance of products. They can also include validation of products.

• The subsection for Work Breakdown Structure should establish a top-level WBS to estimate the scope of the project. The development of a WBS divides the overall project into an interconnected set of manageable components. The WBS is typically a product-oriented structure that provides a scheme for identifying and organizing the logical units of work to be managed, which are called “work packages.” The WBS provides a reference and organizational mechanism for assigning effort, schedule, and responsibility and is used as the underlying framework to plan, organize, and control the work done on the project. The plan for stakeholder interaction should identify all parties from whom commitment should be obtained. The WBS should permit the identification of the following items:
  o Identified risks and their mitigation tasks
  o Tasks for deliverables and supporting activities, including verification and validation
  o Tasks for skill and knowledge acquisition
Tasks for development of needed support plans, such as configuration management, data management, quality assurance, and verification plans

Tasks for integration and management of non-developmental items

Identify the work packages in sufficient detail to specify estimates of project tasks, responsibilities, and schedule.

The top-level WBS is intended to help in gauging the project work effort in terms of tasks and organizational roles and responsibilities. The amount of detail in the WBS at this more detailed level helps in developing realistic schedules, thereby minimizing the need for management reserve. Identify work products (or components of work products) that will be externally acquired.

The top-level WBS developed as an estimation mechanism is typically expanded by decomposing these top levels into work packages that represent singular work units that can be separately assigned, performed, and tracked. Each work package or work product in the WBS should be assigned a unique identifier (e.g., number) to permit tracking. A WBS may be based on requirements, activities, work products, or a combination of these items. A dictionary that describes the work for each work package in the WBS should accompany the work breakdown structure.

The subsection for Deliverable Items should list each separate item that is to be included in a delivery package to an identified customer or end user. Deliverable items can include hardware, software, data products, training material and user documents (e.g. User’s Manual). The subsection should also list each separate item that is to be delivered to the project from a supplier. Deliverable items can be summarized in Giver-Receiver lists. These lists should include a delivery date and acceptance criteria for each item. Deliveries should be included in the IMP (c.f. Section 4.11). Delivery dates should be noted as milestones in the IMS (c.f. Section 4.12).

4.9. Section 5 – Project Lifecycle

Describe the product lifecycle that is planned for the project. Subsections should include Lifecycle Steps and Reviews.

The subsection for Lifecycle Steps should list the steps to be followed during the entire product lifecycle. Usually, a project will follow the 11 standard STAR EPL steps, as described in PG-1. Under some conditions, a project may tailor its lifecycle.
A tailoring rationale should be provided to explain why this tailoring is justified. Special attention should be paid to circumstances where a project has begun its development without following the STAR EPL steps. In that case, it should be explained how the project intends to compensate for missing steps.

- The subsection for Reviews should list the planned Technical Reviews and Gate Reviews. It is recommended that each review be described in its own subsection.
  - For each review, state the review objectives. Note any deviations from the standard STAR EPL review objectives, as documented in the Peer Review Guidelines (PRGs) for each review. A tailoring rationale should be provided to explain why deviations are justified.
  - For each review, state the review entry criteria and exit criteria. Note any deviations from the standard STAR EPL review criteria. A tailoring rationale should be provided to explain why deviations are justified.
  - For each review, identify the review check list items. If the standard STAR EPL check list is adopted, state this and refer to the appropriate STAR EPL Check List (CL) process asset. If a review checklist has been tailored, include the tailored check list as an Appendix to the DPP. This appendix should be in a separate Excel file. Use the STAR EPL CL process assets as templates to create this file.

4.10. Section 6 – Technical

Describe the plan for the technical execution of the project. The technical approach defines a top-level strategy for development of the products. It includes decisions on architectural features, such as distributed or client server; state-of-the-art or established technologies to be applied, and breadth of the functionality expected in the final products, such as safety, security, and ergonomics. Subsections should include Requirements, Constraints, Tasks, Work Products, Resources, Risks and Corrective Actions.

- The subsection for Requirements should state all known project requirements. This subsection will typically be updated during the project lifecycle as requirements are developed, analyzed, and reviewed.
  - Include process requirements. These should be tailored from STAR’s set of standard practices (PG-1), using tailoring guidelines (PG-2). It is sufficient to note what is tailored only (i.e., it is not necessary or recommended to
describe the entire set of standard practices). If there are no tailored practices, note that the organization's set of standard practices is adopted.

- Include product requirements, based on customer/user needs and expectations, and based on any requirements analysis that occurs during the project lifecycle.

- Include system requirements. These are requirements on external interfaces, security, software, development, transition, operational and test environments, delivery and maintenance.

- Include requirements on the development and operational environments, to the extent possible. Note any special requirements that will not be met by the current environments.

- Include staffing requirements. The staffing of a project depends on the decomposition of the project requirements into tasks, roles, and responsibilities for accomplishing the project requirements as laid out within the work packages of the WBS. Staffing requirements must consider the knowledge and skills required for each of the identified positions.

  - The subsection for Constraints should identify constraints. Factors that limit the flexibility of management options need to be identified as early as possible. The examination of the attributes of the work products and tasks will often surface these issues. Such attributes can include task duration, resources, inputs, and outputs.

  - The subsection for Tasks should identify at a high level the stakeholder tasks that are derived from the work tasks identified in the previous section. Examples of high level tasks: "Develop requirements", "Develop interfaces", "Develop software units". Stakeholder tasks will be described in greater detail in the IMP (c.f. Section 5.11).

  - The subsection for Work Products should list the expected work products, including their purpose and planned distribution. Work products include any tangible item this will be produced by project stakeholders in the course of working their tasks. These include the project artifacts and project reports. Work products that are to be treated as reviewable project artifacts should be identified as such. Note the reviews for which each project artifact is to be reviewed. If there has been any tailoring of the STAR standard list of project artifacts, the DPP should contain a list of added and/or deleted artifacts, identified as such.

    - Use appropriate methods to determine the attributes of the work products that will be used to estimate the resource requirements. Methods for determining size and complexity should be based on validated models or historical data. Examples of size measures include the following:
The level of detailed description of the work products is expected to increase throughout the product lifecycle, as the design matures.

- The subsection for Resources should identify the specific resources that have been allocated to meet the requirements. This includes hardware and software resources, personnel, and suppliers. Include resources (e.g., training, materials, time, funding) needed to ensure stakeholder involvement as planned.
  - Examples of critical computer resources include the following:
    - Memory, disk, and network capacity
    - Processor power
    - Communications channel capacity
    - Workstation power
    - Peripheral capacity
  - Examples of software-engineering facilities include the following:
    - Host computers, peripherals, and networks
    - Software test computers and peripherals
    - Target computer environment software
    - Software-engineering environment (i.e., software tools)
  - Select mechanisms for providing needed knowledge and skills. Example mechanisms include the following:
    - In-house training (both organizational and project)
External training

Staffing and new hires

External skill acquisition

- The choice of in-house training or external outsourcing for the needed knowledge and skills is determined by the availability of training expertise, the project's schedule, and business objectives.

- When possible, use historical data to estimate resource requirements. There may be occasions where the available historical data does not apply, such as where efforts are unprecedented or where the type of task does not fit available models. Unprecedented efforts are more risky, require more research to develop reasonable bases of estimate, and require more management reserve. The uniqueness of the project must be documented when using these models to ensure a common understanding of any assumptions made in the initial planning stages.

The subsection for Risks should identify potential risks to the successful technical execution of the project plan.

- Risks must be identified and described in an understandable way before they can be analyzed. When identifying risks, it is good to use a standard method for defining risks. Historical data should be used where appropriate. Include a prioritization of the risks, based on a determination of the impact, probability of occurrence, and time frame in which problems are likely to occur.

- For each identified risk, provide a plan for managing the risk (e.g., mitigation through defined actions (TBS in the Project Status Report), lowering or deferring technical performance requirements, negotiating more resources, finding ways to increase productivity, outsourcing, adjusting the staff skill mix, revising all plans that affect the project or schedules).

The subsection for Corrective Actions should explain when and how corrections to the project plan are approved and implemented.

- Criteria should be established for determining what constitutes a significant deviation from the project plan. A basis for gauging issues and problems is necessary to determine when a corrective action should be taken. These should be as quantitative as possible. Examples of quantitative correction criteria include:
  - Technical performance parameters falling below a defined threshold
- EVMS indices (e.g., Schedule Performance Index (SPI), Cost Performance Index (CPI)) deviating from a defined range
- Number of high risks exceeding a defined threshold
  - The corrective actions may require re-planning, which may include revising the original plan, establishing new agreements, or including mitigation activities within the current plan. DPP should refer to budget and schedule corrective action criteria, noting how these will be applied or tailored to the specific project. Criteria for a re-plan should be explicitly noted, along with a mechanism for monitoring the project to determine whether a re-plan is needed.

4.11. Section 7 – Integrated Master Plan

The Integrated Master Plan (IMP) organizes the project into a sequence of activities (process steps, tasks, reports, reviews) that provide the roadmap for meeting project requirements. The IMP documents significant accomplishments with pass/fail criteria for both business and technical elements of the project and ties each accomplishment to a key program event.

- Identify major milestones. Milestones include scheduled reviews and deliveries. Milestones are often imposed to ensure completion of certain deliverables by the milestone. For each milestone:
  - Note whether it is event based or calendar based. Calendar based milestones are typically driven by external delivery requirements. Event based milestones typically consist of internal task dependencies.

- List the major tasks (e.g., "Write ATBD v2r1") preferably in the order in which they should be accomplished. These should be consistent with the high level tasks identified in Section 6. That is, each major task should be directly traceable to one of the high level tasks. Typically, the tasks for a project can be accomplished in some ordered sequence that will minimize the duration of the project. This involves the identification of predecessor and successor tasks to determine the optimal ordering. Each major task should be entered into a Microsoft Project file as a "Task-Level" item (c.f. Section 5.12). For each major task:
  - Identify the project objective, project requirement and/or SOW item that is satisfied, completely or partially, by the accomplishment of the task.
  - Identify predecessor tasks. These should already have been listed in this section.
o Identify the criteria for initiating the task. Typically, this will consist of satisfying the accomplishment criteria for predecessor tasks.
o Identify subtasks, to the extent possible.
o Identify the task’s work products
o Identify the criteria for task accomplishment
o Identify the review or reviews at which the task’s accomplishment’s will be verified

• For each major task, identify the stakeholders that are affected by the activity and those who have expertise that is needed to conduct the activity. A two-dimensional matrix with stakeholders along one axis and project tasks along the other axis is a convenient format for accomplishing this identification. The list of relevant stakeholders will probably change as the project moves through the phases of the project life cycle. It is important, however, to ensure that relevant stakeholders in the later phases of the life cycle have early input to requirements and design decisions that affect them.

• Include project reports to senior management. These reports should be written by the Project Lead. The frequency of such reports (e.g., monthly) should be established. The target audience for these reports among senior management should be identified.

• Include documented commitment to the IMP from the needed relevant stakeholders. Verify that stakeholder commitments are based on confidence that the work can be performed within cost, schedule, and performance constraints. Often, a provisional commitment is adequate to allow the effort to begin and to permit research to be performed to increase confidence to the appropriate level needed to obtain a full commitment. Document all organizational commitments, both full and provisional, ensuring appropriate level of signatories. Commitments must be documented to ensure a consistent mutual understanding as well as for tracking and maintenance. Provisional commitments should be accompanied by a description of the risks associated with the relationship.

4.12. Section 8 – Integrated Master Schedule

The Integrated Master Schedule (IMS) maps the IMP to a calendar-based schedule, based on the estimate of effort and available resources for each task and its sub-tasks. The IMS is used to track day-to-day progress and includes the continual assessment of the technical parameters required to support each IMP task/event.
Identify schedule assumptions. When schedules are initially developed, it is common to make assumptions about the duration of certain activities. These assumptions are frequently made on items for which little if any estimation data is available. Identifying these assumptions provides insight into the level of confidence (uncertainties) in the overall schedule.

The IMS should satisfy all calendar based milestones and should allow for event based milestones that will ensure that the calendar based milestones are achieved. Be sure to include intermediate milestones (e.g., dates for the delivery of project artifacts to reviewers).

Include a resource-loaded schedule in a Microsoft Project file. This file should include all of the major tasks, subtasks and milestones that were identified in the IMP (c.f., Section 7), with their identified linkages.

4.13. Section 9 – Budget

Document the plan for allocating funds and managing costs. Subsections should include Cost, Funding, Risks, and Earned Value Management.

The subsection for Cost should estimate the cost for the work products and tasks based on estimation rationale. Use the Project Proposal as a reference, and make adjustments as warranted.

- Refer to the models or historical data that are being used to transform the attributes of the work products and tasks into estimates of the labor hours and cost. Historical data include the cost, effort, and schedule data from previously executed projects, plus appropriate scaling data to account for differing sizes and complexity. Scaling data typically include the following:
  - The extent to which the effort is unprecedented
  - Critical competencies and roles needed to perform the work
  - Product and product-component requirements
  - Technical approach
  - Size estimates of work products and anticipated changes
  - Cost of externally acquired work products
  - Selected project life-cycle model and processes
  - Life-cycle cost estimates
  - Capability of tools provided in engineering environment
- Skill levels of managers and staff needed to perform the work
- Knowledge, skill, and training needs
- Facilities needed (e.g., office and meeting space and workstations)
- Engineering facilities needed
- Capability of manufacturing processes
- Travel
- Level of security required for tasks, work products, hardware, software, personnel, and work environment
- Service-level agreements for call centers and warranty work
- Direct labor and overhead

- Include supporting infrastructure needs when estimating effort and cost. The support infrastructure includes items needed from a development and maintenance perspective for the product. Consider critical computer resources in the host environment, in the test environment, in the target environment, or in any combination of these.

- It is prudent to increase the cost estimate an insurance against unexpected costs. This is known as cost margin. Margin is typically indicated as a fraction, or percentage, over the planned cost. Unexpected costs often occur because the data used for cost estimation are incomplete or not fully quantified. Underestimate of cost is most prevalent at the beginning of a project, when requirements and design are incomplete and when the productivity of project stakeholders is relatively undetermined. Use historical data from within the organization, when possible, to determine the cost margin. If necessary, use external historical data.

The subsection for Funding should identify the funding sources and the mechanisms for delivering the required funding in a timely manner.

- All funding agreements between project stakeholders should be documented, either explicitly in the DPP or by reference to external documents (e.g. contracts, MOUs).
- Identify the expected funding schedule with a granularity that allows it to be compared to the cost schedule.
- Compare the available funding schedule to the cost schedule. Identify the difference between the two. This difference (available funding minus the cost) is the “real cost margin”.

The subsection for Risks should identify budget risks and establish a plan for managing them. Budget risks typically include:

- Technical difficulties that require additional unplanned effort
- Interruptions in funding
• Loss of key personnel
• Schedule delays
• Low real cost margin

The subsection for Earned Value Management should establish an Earned Value Management System (EVMS) for the project. Earned value is the planned (i.e., budgeted) cost for the work that has been accomplished. Earned value management is the process of monitoring a project’s accrual of earned value to ensure that project expenditures are producing the expected quantity and quality of work products. A low-risk EVMS should follow the organization’s established EVMS practices. EVMS practices and tools should be described in this subsection.

4.14. Section 10 – List of References

This section should consist of a List of References that includes all references cited in the document. Include all references deemed useful by the Product Team. References should be listed in alphabetical order. References that begin with an author list should begin with the last name of the lead author. A template is provided in Appendix B.
APPENDIX A. - EXAMPLES

An example of a DPP that follows the STAR standards and guidelines will be developed and made accessible from the STAR Process Asset Repository (PAR).
APPENDIX B - TEMPLATES

This appendix contains templates for specific pages and sections of the DPP.
B.1 Cover Page Template:
In this template, <X> = 1.0 for version 1, <X> = 1.1 for version 1 revision 1, <X> = 2.0 for version 2 etc. <Project Name> should be the actual approved name of the Project.
B.2 Document Header Template:
In this template, \(X\) = 1.0 for version 1, \(X\) = 1.1 for version 1 revision 1, \(X\) = 2.0 for version 2 etc.

In this template, \(<\text{Project Name}>\) should be the actual approved name of the Project.

In this template, \(Y\) = the actual page number.

In this template, \(Z\) = the actual total number of pages

---

NOAA/NESDIS/STAR

DEVELOPMENT PROJECT PLAN
Version: \(X\)
Date: \(<\text{Date of Latest Signature Approval}>\)

\(<\text{Project Name}>\)
Development Project Plan

Page \(Y\) of \(Z\)

---

B.3 Document Cover Page Footer Template:

Hardcopy Uncontrolled

---

B.4 Document Footer Template:

Hardcopy Uncontrolled
### Approval Page Template:

In this template, $<X>$ = 1.0 for version 1, $<X>$ = 1.1 for version 1 revision 1, $<X>$ = 2.0 for version 2 etc. $<Project Name>$ should be the actual approved name of the Project.

**TITLE:** $<PROJECT NAME>$ DEVELOPMENT PROJECT PLAN VERSION $<X>$

**AUTHORS:**
- [Lead Author]
- [Co-Author 1]
- [Co-Author 2]
- [etc.]

**APPROVAL SIGNATURES:**

<table>
<thead>
<tr>
<th>Name of Project Development Lead</th>
<th>Date</th>
<th>Actual Signature Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Name of Project Development Lead]</td>
<td>[Date]</td>
<td>[Actual Signature Date]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name of Project Manager</th>
<th>Date</th>
<th>Actual Signature Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Name of Project Manager]</td>
<td>[Date]</td>
<td>[Actual Signature Date]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name of Agency Approver</th>
<th>Date</th>
<th>Actual Signature Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Name of Agency Approver]</td>
<td>[Date]</td>
<td>[Actual Signature Date]</td>
</tr>
</tbody>
</table>
B.6 Version History Page Template:

In this template, <Project Name> should be the actual approved name of the Project.

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Revised Sections</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Created by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for Gate 3 Review.</td>
<td>New Document</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>1.1</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; to describe changes</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>1.2</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; to describe changes</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>2.0</td>
<td>Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; for Gate 4 Review</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>2.1</td>
<td>[As needed] Revised by &lt;Name of Developer(s)&gt; of &lt;Name of Developers’ Agency/Company&gt; to describe changes</td>
<td>&lt;applicable sections&gt;</td>
<td>&lt;Actual date of Latest approval signature&gt;</td>
</tr>
<tr>
<td>2.2</td>
<td>Ditto</td>
<td>Ditto</td>
<td>Ditto</td>
</tr>
<tr>
<td>etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
B.7 Figure Caption Template:

Figure 2.3 - <Figure caption in Arial regular 12 point font>

B.8 Table Title Template:

Table 4.5 - <Table title in Arial regular 12 point font>
B.9 List of References Template:


END OF DOCUMENT